Introducing WyseTerm
WyseTerm is a communications and terminal emulation program that
supports ANSI-BBS, SCO ANSI, WYSE-50, WYSE-60, VT320, VT220
(also supports VT220 7 bit or 8 bit, VT100, or VT52), and DG-210
terminal modes. WyseTerm lets a user at one site access a remote host
as if the user display was locally attached.
Warning! Some TCP/IP stacks have problems with out-of-band data. If WyseTerm connects to your
host, but never displays any host data, you may be experiencing this problem. To work
around the problem, add the following entry in the Registry database:
HKEY_CURRENT_USER\Software\Hummingbird\productname\Telnet\General
value name=Disable OOB
value type=DWORD
value data=1

Related Topics
Connecting to a Host

Connecting to a Host
To Connect to a host you must complete the following three procedures.
1. Confirm the connection requirements.
2. Select the terminal emulation mode.
Note:

Select the terminal emulation mode before you connect to a host. If you change the
terminal emulation mode during a connection, it clears the information in the display
window.

3. Select the protocol. The connection procedure varies slightly
depending on the protocol you select:
Establishing a New Rlogin Protocol Connection
Establishing a New Tapi Protocol Connection
Establishing a New Telnet Protocol Connection

Fulfilling Connection Requirements
Making a connection with a remote host requires following:
A TCP/IP transport protocol
A Telnet daemon running on the host
Note:
You must have Telnet privileges assigned in the InetD Admin application if a PC
host is running the Hummingbird Telnetd application.
For a PC running Windows NT/2000/XP/2003 to successfully access the
machine, the PC must be a member of the TelnetAccess group and the group
must exist in the user administration program. If the group does not exist, every
user with an account can access the machine.

If you are using the Rlogin protocol, you need an .rhosts file in your
Home directory on the host.
If you are using the Tapi protocol, you need:
A Tapi compatible modem.
A host that can accept serial connections, and the phone number of
the host.
Related Topics
Establishing a New Rlogin Protocol Connection
Establishing a New Tapi Protocol Connection
Establishing a New Telnet Protocol Connection

Establishing a New Rlogin Protocol Connection
The Connect dialog box opens automatically when you start WyseTerm.
But, with new connections you should close the Connect dialog box and
set the Terminal emulation mode first. If you change the terminal
emulation mode after you make a connection, WyseTerm clears the
information in the Telnet window. To set the terminal emulation mode
before you connect, click Cancel in the Connect dialog box. This returns
you to the WyseTerm window.
To establish a new Rlogin protocol connection:
1. On the Settings menu, select the terminal emulation mode.
2. On the Connection menu, click Connect.
3. In the WyseTerm display window, select the Rlogin protocol.
4. Fill in the required boxes on the Host tab:
a. In the Host box, type the name or IP address of the host machine.
b. To change the default port number of 513, specify the new port
number in the Port box.
c. To load an existing settings file, type the file name in the Terminal
Setup File box, or click Browse to find an existing file.
5. Fill in the required boxes on the General tab.
6. Fill in the required boxes on the Rlogin tab:
a. In the Host Login Name box, type your user name on the host.
b. Click Apply to save your connection configuration.

If you plan on making regular connections to the host, create a
shortcut that stores your connection configurations.
Related Topics
Creating and Using Connection Shortcuts
Creating Folders

Establishing a New Telnet Protocol Connection
The Connect dialog box opens automatically when you start WyseTerm.
But, with new connections you should close the Connect dialog box and
set the terminal emulation mode first. If you change the terminal
emulation mode after you make a connection, WyseTerm clears the
information in the Telnet window. To set the terminal emulation mode
before you connect, click Cancel in the Connect dialog box. This returns
you to the WyseTerm window.
To establish a new Telnet protocol connection:
1. On the Settings menu, select the terminal emulation mode.
2. On the Connection menu, click Connect.
3. In the WyseTerm display window, select the Telnet protocol.
4. Fill in the required boxes on the Host tab:
a. In the Host box, type the name or IP address of the host machine.
b. To change the default port number of 23, specify the new port
number in the Port box.
c. To load an existing settings file, type the file name in the Terminal
Setup File box, or click Browse to find an existing file.
5. Fill in the required boxes on the General tab.
6. Fill in the required boxes on the Telnet tab.

If you plan on making regular connections to this host, create a
shortcut to store your connection configurations.
Related Topics
Creating and Using Connection Shortcuts
Creating Folders

Establishing a New Tapi Protocol Connection
The Connect dialog box opens automatically when you start WyseTerm.
But, with new connections you should close the Connect dialog box and
set the Terminal emulation mode first. If you change the terminal
emulation mode after you make a connection, WyseTerm clears the
information in the Telnet window. To set the terminal emulation mode
before you connect, click Cancel in the Connect dialog box. This returns
you to the WyseTerm window.
To establish a new Tapi protocol connection:
1. On the Settings menu, select the terminal emulation mode.
2. On the Connection menu, click Connect.
3. In the WyseTerm display window, select the Tapi protocol.
4. Fill in the required boxes on the Tapi tab.
5. Fill in the required boxes on the General tab.
Note:

Remember to turn the Debug File off the next time you want to use this connection;
otherwise, the file grows considerably.

If you plan on making regular connections to this host, create a shortcut
to store your connection configurations.
Related Topics
Creating and Using Connection Shortcuts
Creating Folders

Creating and Using Connection Shortcuts
For host connections that you use frequently, create a shortcut to store
your connection information.
To create a shortcut:
1. On the Connection menu, click Connect.
2. In the Connect dialog box, click New.
3. In the Name box, type the name of the shortcut.
4. Specify the protocol from the Type drop-down list box.
5. Click OK.
6. On the Host tab, type the host name or IP address in the Host box.
7. If you need to change the default port number, type the new port
number in the Port box.
8. Click OK.
The shortcut appears in the WyseTerm display window with a letter “R” or
“T” to indicate that WyseTerm uses the Rlogin or Telnet protocol and a
letter “S” to indicate that WyseTerm uses the Tapi protocol. After you
create a shortcut, you can connect to that host by double-clicking the
appropriate icon in the WyseTerm display window.
Note:

You can also use the information saved with the shortcut to start WyseTerm from a command
line.

Starting WyseTerm From a Command Line
Start WyseTerm by using:
traditional command line parameters
folders and icons in the Connect dialog box as command line
parameters

Using a Command Line
To start WyseTerm, type the following in any command line:

home\htelnet /t | /r @settings.hts host port# /s
script.ebx
where:
home

is your Home directory.

/t

an optional setting that specifies the Telnet protocol. This is the default protocol if
you do not specify another one.

/r

an optional setting which specifies the Rlogin protocol.

@settings.hts

specifies that you want to use the settings contained in the Telnet Settings file
settings.hts. The file specification should include the complete path to the file
(for example, c:\user\sparc.hts). If you do not specify a file extension,
WyseTerm automatically assigns the .hts extension.

Host

is the name or IP address of the host to which you want to connect.

Port#

if you specify a host, you can also specify the port# (in decimal value) for the host
to which you want to connect. If you do not specify a port# or a settings.hts
file on the command line, WyseTerm uses the default port number of 23.

/s script.ebx

is the name of a Hummingbird Basic script file.

Examples
"c:\ home directory\htelnet @vt220.hts sparc 23 /s login.ebx"

If the path includes a directory name that includes a space, enclose the
path with quotation marks. You must also include the .exe extension to
htelnet. For example,
"c:\Program Files\ home directory\htelnet.exe" @"c:\ USER\
sparc.hts" sparc 23 /s login.ebx

Using the Connection Dialog Box Window
To start WyseTerm, type the following in any command line:

home\htelnet /f foldername /i iconname
where:
home

is your Home directory.

/f foldername

is the folder name of the icon that you want to use (that displays in the
Connect dialog box window).

/i iconname

is the name of the icon (Telnet or Rlogin) that stores all the connection
information that displays in the Connect dialog box.

Example
c:\home\htelnet /f ourhosts /i mailhost
Note:

If the path includes a directory name that includes a space, enclose the path
with quotation marks.

Creating Folders
You can create folders to organize multiple shortcuts.
To create a folder:
1. On the Connection menu, click Connect.
2. In the Connect dialog box, click New.
3. In the New Entry dialog box, select Folder from the Type drop-down
list box.
4. In the Name box, type the name of the folder you want to create.
5. Click OK.
Related Topics
Creating and Using Connection Shortcuts

Creating Settings Files
You can create a customized settings file if you want to adjust the default
settings. In most cases, the default settings are appropriate. However,
you may want to customize connections to different hosts.
To create a settings file:
1. On the Settings menu, click Terminal.
2. On each tab, configure your display to emulate a particular terminal.
3. Click OK.
4. On the File menu, click Save As.
5. In the File name box, type the file name. Telnet uses the default
extension (.hts) if you do not specify an extension. Settings files
reside in the User directory by default, but you can specify another
location.
Related Topics
Modify Terminal Setup Dialog Box

Changing the Colors of the Display Window
You can format host-generated messages to visually distinguish them in
the WyseTerm window. You can accent any host-generated text attribute
(normal, bold, blink, or underline) with a color (background or foreground)
in the WyseTerm window. When the host requests text with any of these
attributes, WyseTerm displays the attribute in the color assigned to that
attribute.
To change the colors of the display window:
1. On the Settings menu, click Terminal.
2. In the Modify Terminal Setup dialog box, click the Colors tab.
3. Select a display format from the Attribute drop-down list box.
4. In the Foreground Color box, select a foreground color.
5. In the Background Color box, select a background color.
6. To change the characteristics of any of the attributes, check the
applicable box at the bottom of the Colors tab.
7. Click OK.
To invert the color scheme you have selected:
1. On the Modify Terminal Setup dialog box, select the Display tab.
2. Select the Reverse background check box in the Miscellaneous area.
3. Click OK.
To redefine Reverse and Dim attributes:
Open the htelnet.ini file located in the Accessories folder of the
Hummingbird user directory. By editing this file, you can define how
Reverse and Dim text is displayed in the session window.
By default, all lines in the file are commented out. Remove the comment
marker at the beginning of the lines that you want to modify. The
available foreground and background color values are listed for you.
After you save your changes to the file, you must close and restart any

open WyseTerm sessions for the changes to take effect.

Printing Information in the WyseTerm Window
To print information in the WyseTerm window, select the text you want
printed and click Print on the File menu. If you do not select the text, the
whole window prints.
WyseTerm supports passthrough printing of remote files. This means you
can print host files through WyseTerm to a local or network connected
printer. As a result, you may need to specify the printer using Print Setup.

Defining a Button
You can map buttons to generate specific character strings.
Note:

Buttons 13 through 30 are available. Buttons F1 through F12 are preset.

To select and define a button:
1. On the Settings menu, click Terminal.
2. In the Modify Terminal Setup dialog box, click the Button Mapping tab.
3. Select one of the definable buttons from the Buttons list box. Buttons
13 through 30 are placeholders for new buttons.
4. To use the new button in the WyseTerm window, clear the Not Used
check box.
5. In the Button Name box, type the name of the button.
6. In the String To Send box, specify the command string to forward to
the host.
7. Click OK.

Removing a Button
You can remove a button from your WyseTerm window without removing
the button from the list box. Select the button in the display window and
check the Not Used box. You can use the current mapping of this button
in the future by clearing the same box.
Related Topics
Button Mapping Tab
Modify Terminal Setup Dialog Box

Mapping the Telnet Keyboard
The keyboards of host terminals contain host keys that may not be found
on your PC. Access the functionality of these terminals by associating PC
keystrokes to the host keys in the Key Mapper.
To map PC keystrokes to host keys:
1. On the Settings menu, click Terminal.
2. On the Keyboard tab, type a keyboard map file name in the Keyboard
Map File box and click Edit. To edit the existing keyboard map file,
leave the file listed and click Edit.

The Key Mapper displays a color-coded PC keyboard that lets you
quickly identify the status of keys in the map file. Dimmed keys
cannot be mapped (for example, Caps Lock). Light blue keys have
already been mapped to a host key. Modifier keys are outlined in
dark blue. When you select a key, it appears in yellow.
3. In the Mapping Mode group box, select what you would like to
map to the key.
Host Key—Maps a predefined host key to any PC key
combination.
Macro—Maps a string (predefined or user-defined) to any PC key
combination. When you click this radio button, a box appears
below the Mapping Mode group box. Type the string you want to
map in the box.
4. Determine the availability of the host key or PC key combination.
5. To delete the current mapping of a key, either highlight the host
key in the Host Keys display window and click Clear, or select the
PC key on the Keyboard display and click Clear. You do not need
to delete the current mapping of a PC key before you remap it.
6. In the Host Keys display window, select the host key to which you
want to map.

7. On the Keyboard display, select the PC key combination you want
to map to the host key.
8. Click Map.
The Key Mapper also supports drag-and-drop key mapping. To map a
host key to a PC key, select the host key from the Host Keys display
window, and drag it to the PC keyboard.

Enabling the ISO Latin2 Character Set
Enabling the ISO Latin2 character set allows your keyboard to support
extended characters.
To enable the ISO Latin2 character set:
1. Rename the intmap.tbl file to intmap.tbm.
2. Run Telnet and select the VT320 terminal emulation mode.
3. In the VT320 tab of the Modify Terminal Setup dialog box, clear the
following check boxes:
National (or Multinational Character) Set
User Preferred Character Set
4. In the Fonts dialog box, change the font to match the same ISO Latin
font you are using.
If you need an ISO Latin character set other than 1 and 2, contact the
Hummingbird Sales department for more information.

Using DDE and OLE
If you are familiar with DDE and OLE, you can use this scripting language
to automate the transfer of data in Telnet.

General Accessibility
Hummingbird products are accessible to all users. Wherever possible,
our software adheres to Microsoft Windows interface standards and
contains a comprehensive set of accessibility features.
Access Keys All menus have associated access keys (mnemonics) that
let you use the keyboard, rather than a mouse, to navigate the user
interface (UI). These access keys appear as underlined letters in the
names of most UI items. (If this is not the case, press Alt to reveal them.)
To open any menu, press Alt and then press the key that corresponds
with the underlined letter in the menu name. For example, to access the
File menu in any Hummingbird application, press Alt+F.
Once you have opened a menu, you can access an item on the menu by
pressing the underlined letter in the menu item name, or you can use the
arrow keys to navigate the menu list.
Keyboard Shortcuts Some often-used menu options also have shortcut
(accelerator) keys. The shortcut key for an item appears beside it on the
menu.
Directional Arrows Use the directional arrows on the keyboard to
navigate through menu items or to scroll vertically and horizontally. You
can also use the directional arrows to navigate through multiple options.
For example, if you have a series of radio buttons, you can use the arrow
keys to navigate the possible selections.
Tab Key Sequence To navigate through a dialog box, press the Tab key.
Selected items appear with a dotted border. You can also press Shift+Tab
to go back to a previous selection within the dialog box.
Spacebar Press the Spacebar to select or clear check boxes, or to
select buttons in a dialog box.
Esc Press the Esc key to close a dialog box without implementing any
new settings.
Enter Press the Enter key to select the highlighted item or to close a
dialog box and apply the new settings. You can also press the Enter key
to close all About boxes.

ToolTips ToolTips appear for all functional icons. This feature lets users
use Screen Reviewers to make interface information available through
synthesized speech or through a refreshable Braille display.

Microsoft Accessibility Options
Microsoft Windows environments contain accessibility options that let you
change how you interact with the software. These options can add
sound, increase the magnification, and create sticky keys.
To enable/disable Accessibility options:
1. In Control Panel, double-click Accessibility Options.
2. In the Accessibility Options dialog box, select or clear the option
check boxes on the various tabs as required, and click Apply.
3. Click OK.
If you installed the Microsoft Accessibility components for your Windows
system, you can find additional accessibility tools under Accessibility on
the Start menu.

Technical Support
You can contact the Hummingbird Technical Support department Monday
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.
Hummingbird Ltd.
1 Sparks Avenue, Toronto, Ontario, Canada M2H 2W1
Canada and the USA
Technical Support: 1-800-486-0095
General Enquiry: 1-877-FLY-HUMM

International
+1-416-496-2200
+1-416-496-2200

Main: +1-416-496-2200
Fax: +1-416-496-2207
E-mail: support@hummingbird.com
FTP: ftp.hummingbird.com
Web Support: support.hummingbird.com/customer
Web Site: www.hummingbird.com

Modify Terminal Setup Dialog Box
To access
The Modify Terminal Setup dialog box lets you set up your terminal
emulator by modifying the settings in the following tabs:
Terminal Emulation Mode-Specific Tabs—This is specific to the
terminal emulation mode that you selected on the Settings menu.
Depending on what emulation mode you use, you need to specify
emulation mode-specific information for either the ANSI-BBS, SCO ANSI,
VT220, VT320, WYSE-50, WYSE-60, or DG-210 mode.
Display—This tab lets you specify the various attributes of the
WyseTerm window. For example, the number of lines and columns that
appear in the WyseTerm window, whether or not the text wraps
automatically, the cursor style, and so on.
Colors—This tab lets you customize the color of your screen by
emulating the color of the host attributes. The colors you set in this tab
are not altered by the color settings you make in the Windows Control
Panel.
Keyboard—This tab lets you modify the characteristics of your keyboard.
It also lets you display the Key Mapper which you can use to remap your
keyboard.
Button Mapping—This tab lets you remap the buttons (user keys) that
appear in the bottom of the WyseTerm window (for example, Find or
PF1), or add new buttons to the window.
Capture—This tab lets you customize when and how captures are made,
and to specify where the capture resides.
Tabs Stops—This tab lets you specify the number and distance of the
tab stops in the WyseTerm window.
When you finish setting up your display, save these settings to a
WyseTerm settings (.hts) file which you can then load the next time you
connect to that host.
Note:

You can also modify any of the settings in the Modify Terminal Setup dialog box using DDE or
OLE.

